
 

 
PCS 7 SMART 

Manual

Valid for PCS 7 SMART as of V8.1

 
09/2014
A5E34636658-AA

Preface 1

System Requirements 2

Licenses 3
Differences between PCS 7 
SMART and PCS 7 ASIA 4

Hardware catalog 5
Switching from 
PCS 7 SMART to PCS 7 ASIA 6



Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
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Preface 1
PCS 7 SMART

PCS 7 SMART is a powerful process control system which introduces you to process 
automation. Even less experienced users can build an automation system and benefit from 
the advantages of automation technology with this easy-to-use system. 

PCS 7 SMART is suitable for companies that need cost-efficient automation for small plant 
configurations.

Purpose of this documentation
This documentation highlights the differences between the PCS 7 SMART process control 
system and PCS 7 ASIA.

Guide
The PCS 7 SMART documentation also includes references to the PCS 7 documentation in 
addition to descriptions of the differences compared with PCS 7. This enables you to quickly 
access the required PCS 7 functions. You can find important key words in the index.

Options for accessing PCS 7 documentation
Full versions of the documentation are available on the Internet pages of the "SIMATIC PCS 
7 Technical Documentation (www.siemens.com/pcs7-documentation)".

PCS 7 SMART Readme (DVD version)
The PCS 7 SMART Readme on the DVD contains important information about PCS 7 SMART 
and takes precedence over the documentation that has been supplied with the PCS 7 SMART. 
After installation of PCS 7 SMART, you will find the document Process Control System PCS 
7; PCS 7 Readme in the Windows Start menu using the following path: 
Siemens Automation > SIMATIC > Product Notes > <language>

PCS 7 SMART Readme (Internet version)
The information provided in the PCS 7 SMART Readme on the Internet takes precedence over 
all PCS 7 SMART documentation. 

Please read this PCS 7 SMART Readme carefully; it contains important information and 
amendments on PCS 7 SMART.

PCS 7 SMART 
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Documentation for PCS 7 on the Internet (current versions)
The latest documentation on the PCS 7 versions is available on the Internet page "Technical 
Documentation SIMATIC PCS 7":

● In the section "Software manuals for SIMATIC PCS 7 ..."

– The link to the latest system and product documentation of the particular PCS 7 version.

– The link to download the Setup for the latest system documentation 
"PCS 7 Documentation Portal Setup". 

– The link to download the entire PCS 7 documentation as a Manual Collection in the My 
Documentation Manager (http://support.automation.siemens.com/WW/view/en/
38715968).
The Manual Collection includes the manuals for hardware and software.

Required basic knowledge
General knowledge in the area of automation engineering and basic knowledge of PCS 7 is 
required to understand this documentation. It is also assumed that the reader knows how to 
use computers or other equipment similar to PCs (such as programming devices) with the 
Windows operating system. The configuration manuals and the Getting Started documentation 
for PCS 7 will provide you with basic information regarding the use of PCS 7.

Conventions
In this documentation, the names of software interface elements are specified in the same 
language used for this documentation. If you have installed a multi-language package for the 
operating system, some of the designations will still be displayed in the basic operating system 
language, even after changing the language. They will therefore differ from the designations 
used in the documentation.

Preface
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System Requirements 2
2.1 Hardware Requirements

PC 
The SIMATIC IPC 347D is a custom-fit option for PCS 7 SMART projects. 

The SIMATIC IPC 347D has the following product features:

 Component
Article No. 6AG4012-0CA22-0BX0
Chip set H61
Processor Intel Core i5-3340S
RAM 4 GB
HDD 500 GB
ODD DVD±ROM
Operating system Windows 7 Ultimate, 64-bit, MUI, SP1

Automation systems 
PCS 7 SMART supports the following CPUs:

● CPU 410‑5H FW V8.1

● CPU 410 SMART FW V8.1

Comparison of CPUs

 CPU 410 SMART CPU 410-5H
Process objects (inclusive) ● 100 ● 100
Process objects (maximum) ● 800 ● 2600 (in conjunction with 

PCS 7 SMART, a maximum of 
2400 POs can be used)

Memory ● 48MB load
● 4MB code
● 4MB data memory

● 48MB load
● 16MB code
● 16MB data memory

Inputs/outputs ● 1536 byte input
● 1536 byte output

● 16000 byte input
● 16000 byte output

Cycle time ● >= 200ms ● 10 ms
Functionality ● No F (process safety), H only

● No SOE (time stamp OB4x)
● HF-CPU (process safety & 

redundancy)
● Time stamp & sequence of 

event (SOE)

PCS 7 SMART 
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 CPU 410 SMART CPU 410-5H
Interfaces ● 1x DP with max. 48 DP slaves

● No external DP master
 
● 2x PN IO controller, in each 

case with 48 devices or 
2x Ethernet or 
1x Ethernet & 1x PN IO 
controller

● DP master with max. 96 DP 
slaves

● Up to 10x external DP master
● 2x PN IO controller, in each 

case with 250 devices or 
2x Ethernet or 
1x Ethernet & 1x PN IO 
controller

Conformal coating Yes
Configuration options Fixed bundles (rack + PS + CPU) Freely configurable

Additional CPU types are not offered in the "STEP 7 HW Configuration".

It is not possible to download a program to other CPUs (e.g., S5, S7‑300, S7‑412/414/416/417, 
etc.).

System Expansion Card (SEC)

CPU 410 SMART
You need a system expansion card to operate a CPU 410 SMART. It is not possible to upgrade 
the process object (PO). The maximum number of POs is limited to 800 and cannot be 
increased or amended. The system expansion card forms a hardware unit with the CPU 410 
SMART.  In redundant operation you must use two 410 SMART CPUs that are each equipped 
with a system expansion card with the same PO quantity.

CPU 410‑5H
You need a system expansion card to operate a CPU 410-5H. The system expansion card 
specifies the maximum number of process objects that can be downloaded. If necessary, the 
specified volumes of the system expansion card can be increased using the 
CPU 410 expansion packs. The system expansion card forms a hardware unit with the CPU 
410-5H. In redundant operation you must use two 410-5H CPUs that are each equipped with 
a system expansion card with the same PO quantity.

System Requirements
2.1 Hardware Requirements
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2.2 Released modules
PCS 7 SMART cannot be used with S7-400 CPU types. All other modules, which are also 
released for PCS 7 ASIA, can be used. You can find a detailed list of approved modules on 
the Internet in the SIMATIC PCS 7 System Documentation (www.siemens.com/pcs7-
documentation) in the manual "Released Modules" under "Software manuals for SIMATIC 
PCS 7".

Note

If you use a CPU 410 SMART, the following limitations apply:
● You cannot operate failsafe modules
● You cannot use the SOE (sequence of event) function

System Requirements
2.2 Released modules
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2.3 System requirements

Operating system
PCS 7 SMART supports the following operating systems:

● Windows 7 SP1 x64 Enterprise

● Windows 7 SP1 x64 Ultimate

PCS 7 SMART does not support any other operating systems.

PCS 7 SMART can be expanded with all standard products (e.g., SIMATIC Process Historian, 
SIMATIC BATCH, etc.). If these products require a different operating system (e.g., Windows 
Server 2008), install the standard products on a separate computer. 

You can find further information on supported operating systems of the standard products 
documentation (http://support.automation.siemens.com/IN/view/en/98784411) in the manual 
"PCS 7 SMART readme online" in the section "Installation instructions".

System configuration
PCS 7 SMART does not support client-server architectures.

● The figure below is an example of the minimum configuration:

Note
OS simulation on an engineering station

An OS simulation on an engineering station requires an OS runtime license.

System Requirements
2.3 System requirements
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● The figure below is an example of the maximum configuration possible:

The architecture can be as follows:

● 1 OS single station system and up to 6 additional OS single station system references 

● 1 OS single station system and 1 redundant OS single station system (single station system 
+ single station system standby)

Additional information concerning the PCS 7 ASIA plant configuration can be found on the 
Internet (http://support.automation.siemens.com/WW/view/en/24023824). Please note 
differences in the configuration limits between PCS 7 ASIA and PCS 7 SMART.

Configuration limits:
● Only one OS project can be created

● The same project runs on each OS

● Maximum volume for AS process objects per project: 2400 POs

● Maximum volume for OS process objects per project: 2400 POs

● Only CPU 410-5H and CPU 410 SMART can be used

● Maximum of 3 web clients simultaneously per web server in one OS single station system

● Client/server is not supported

PCS 7 and PCS 7 SMART comparison 

 PCS 7 PCS 7 SMART
DVD ● ASIA ● SMART
Engineering software ● Available separately ● Only available as 

PCS 7 SMART bundle

System Requirements
2.3 System requirements

PCS 7 SMART 
Manual, 09/2014, A5E34636658-AA 11

http://support.automation.siemens.com/WW/view/en/24023824


 PCS 7 PCS 7 SMART
Languages ● Standard ● English 

● English and Chinese 
(simplified)

Licenses ● Standard ASIA
● ASIA USB hard lock (OS only)

● ASIA & SMART
● SMART USB hard lock (ES & 

OS)
CPU ● S7-41X  

● CPU 410-5H/-SMART
● CPU 410-5H/-SMART

Architecture ● Maximum of 18 servers 
(redundant),

● Up to 40 clients,
● Up to 8 single stations

● Up to 1 redundant single 
station with a maximum of 6 
reference stations

OS process objects ● Maximum of 12000 POs per 
OS project on one OS server 
and 5000 POs per OS single 
station system

● Maximum of 2400 POs per OS 
project on one OS single 
station system

Multiproject ● Standard ● Maximum of 1 OS project in the 
multiproject

Recommended IPCs ● IPC 547, 647, 847 ● IPC 347D

Selecting components to be used in your plant
You can find information on selecting system components in the documentation 
(www.siemens.com/pcs7-documentation) "Software manuals for SIMATIC PCS 7", section 
"PCS 7 Plant Components" in the manual "PCS 7 Engineering System" under "SIMATIC PCS 
7 system documentation".

System Requirements
2.3 System requirements
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2.4 Installation

Language combinations 
The PCS 7 SMART setup offers the following language configurations:

System language Selected user interface 
language in PCS 7 set‐
up

Languages available for 
PCS 7 SMART

Language of the instal‐
led libraries

Chinese
(simplified)

English English (default)
Chinese (optional)

English

Chinese
(simplified)

Chinese
(simplified)

English (default)
Chinese (default)

Chinese
(simplified)

English English English 
(default)

English

Installation of PCS 7 SMART
Start the file Setup.exe on the installation disk and follow the instructions.

System Requirements
2.4 Installation
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Licenses 3
Scope of delivery for the PCS 7 SMART bundles

Below is an overview of the bundles that are available for PCS 7 SMART. The brackets after 
the "✓" symbol indicate the number of components contained. The brackets after the package 
name indicate the article number of the package.

Package name →
Component
↓
 
 
 

Standard bundle (6ES7650-6BB18-0XX0)
 Redundant bundle (6ES7650-6BB18-0XX1)

 Standard bundle w/o IPC (6ES7650-6AB18-0XX0)
 Redundant bundle w/o IPC (6ES7650-6AB18-0XX1)

  Standard bundle w/ CPU 410‑5H
(6ES7650-6BA18-0XX0)
 Redundant bundle w/ 

CPU 410‑5H
(6ES7650-6BA18-0XX1)

IPC 347D1 ✓ (1) ✓ (3)   ✓ (1) ✓ (3)
CPU 410 SMART bundle ✓ (1)2 ✓ (2)2 ✓ (1)2 ✓ (2)3   
CPU 410 bundle 4     ✓ (1)  
CPU 410 red. bundle5      ✓ (1)
IM PA SMART ✓ (1) ✓ (2) ✓ (1) ✓ (2) ✓ (1) ✓ (2)
SoftNet RedConnect6 ✓ (1) ✓ (2) ✓ (1) ✓ (2) ✓ (1) ✓ (2)
PCS 7 V8.1 SW Media Pack‐
age SMART7

✓ (1) ✓ (1) ✓ (1) ✓ (1) ✓ (1) ✓ (1)

PCS 7 V8.1 AS/OS Engineer‐
ing SMART (PO unlim.) 

✓ (1) ✓ (1) ✓ (1) ✓ (1) ✓ (1) ✓ (1)

PCS 7 Runtime License AS 
(PO 100)

✓ (1) ✓ (1) ✓ (1) ✓ (1)   

PCS 7 V8.1 OS Single Sta‐
tion SMART (PO 100)

✓ (1)  ✓ (1)  ✓ (1)  

PCS 7 V8.1 OS Single Sta‐
tion Redundancy SMART
(2x OS RT PO 100)

 ✓ (1)  ✓ (1)  ✓ (1)

1 Win7 64-bit Ultimate preinstalled
2 incl. UC PS 4A + 4‑slot rack
3  incl. 2xPS 4A + 2x4‑slot rack and 2xsynch. cables and modules
4 incl. UC PS 4A + 4-slot rack; IL RT license; AS RT PO 100 license 

5 incl. 2x UC PS 4A + 2x 4‑slot rack; 1x synch cables and modules; 1x IL RT license; 1x AS 
RT PO 100 license 

PCS 7 SMART 
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6 8x single / 4x redundant connections 
7 All other necessary licenses for PCS 7 SMART are PCS 7 ASIA licenses.

Note

The following products are exclusively contained in the PCS 7 SMART bundle and cannot be 
purchased separately:
● PCS 7 V8.1 AS/OS Engineering SMART (PO unlimited)  
● PCS 7 V8.1 OS Single Station Redundancy SMART (2x OS RT PO 100)

The product "PCS 7 OS Single Station SMART (PO 100)", (art. no. 6ES7658-2AA18-5CA0) 
can be ordered separately to expand a plant with an additional OS single station system.

Expanding from PCS 7 SMART with control system components 
You can expand the functionality of PCS 7 SMART  (e.g SIMATIC BATCH, 
SIMATIC Route Control, WebServer, Process Historian, Information Server or Import‑Export 
Assistent). Separate licenses are available for upgrading the additional functions. An overview 
of the control system components is available in the "SIMATIC PCS 7 Standard Catalog ST 
PCS 7" catalog in the catalog search (http://w3app.siemens.com/mcms/infocenter/content/en/
Pages/order_form.aspx?nodeKey=key_516907&infotype=1&linkit=null).

14 day trial mode 
PCS 7 SMART does not include the 14 day trial mode.

PCS 7 SMART OS demo mode
PCS 7 SMART changes to demo mode in the following situations:

● When the maximum number of OS process objects (2400 POs) is exceeded

● When a license is missing

● When a USB hardlock is missing

Demo mode limits the use of PCS 7 SMART as follows:

● In demo mode, the WinCC Explorer and the editors end automatically after 60 minutes.

● In the PCS 7 SMART OS runtime, notification windows pop up at regular intervals referring 
to the active demo mode; these must be confirmed.

USB hardlock 
The USB hardlock for PCS 7 SMART is intended for use with PCS 7 SMART only. Make sure 
that the USB hardlock is permanently inserted in the USB port of the computer on which the 
associated version of PCS 7 SMART is running. If you remove the USB hardlock from the 
computer during runtime, PCS 7 SMART switches to demo mode. 

To avoid loss of the USB hardlock, close and lock the front panel of the IPC.

Licenses
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License upgrade from PCS 7 SMART to PCS 7 ASIA
A license upgrade from PCS 7 SMART to PCS 7 ASIA is not possible. If you want to use 
PCS 7 ASIA, you must purchase the appropriate standard license:

PCS 7 SMART V8.1 PCS 7 V8.1 ASIA Order number
AS/OS Engineering SMART AS/OS Engineering ASIA 6ES7658-5AX18-0CA5
OS Single Station SMART OS Single Station SN ASIA 6ES7658-2AA18-6CA0
OS Single Station Redundant SMART OS Single Station Redundancy SN ASIA 6ES7652-3AA18-6CA0

Note

All other licenses are standard licenses and must not be replaced.

Updating from PCS 7 SMART to a new PCS 7 SMART version
You can update as soon as a new version of PCS 7 SMART becomes available.

Limit on number of process objects (POs) 
Process objects are divided into OS POs (process objects of the operator station) and AS POs 
(process objects of the automation system).

Each PCS 7 SMART bundle comes with 100 OS POs. You can increase the number of POs 
by upgrading with a license package. The maximum number of process objects (POs) per OS 
single station system or per PCS 7 SMART project is limited to 2400.

When the number of used POs exceeds the limit of 2400, the following happens:

● AS: AS-OS transfer is not possible

● OS: A notification window pops up and the OS switches to demo mode

Process objects (POs)
The points below apply to the licensing of process objects "POs":

The following are counted as PCS 7 process objects: 

● All SFCs

● All block instances that meet the following criteria:

– Instance can be controlled and monitored.

– Instance generates alarms.

– Instance is not part of the driver library.

These objects are transferred to the OS and must be licensed. 
A block that can be controlled and monitored has the attribute "S7_m_c = true" in the 
CFC block properties.

Licenses
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A process object can include one of the following blocks and objects:

● Blocks for operating and monitoring a system

● Objects for automation

● Objects for signal recording and signal processing

You can find additional information on process objects in the documentation 
(www.siemens.com/pcs7-documentation) "Software manuals for SIMATIC PCS 7" in the 
manual "Licenses and configuration limits" manual under "Read Me & Licenses". 

Available license packages (PO licenses)
There are no special PO licenses available for PCS 7 SMART. If you want to expand the 
number of process objects in PCS 7 SMART, use the PO licenses for PCS 7.

You can choose from the following PCS 7 licenses:

Component of process con‐
trol system

License level Comments

Operator station (OS) PO:
● 100
● 1000

License key "OS RT PO"
● Single station system: maximum 

2400 POs

Archiving with operator sta‐
tion

Archive values:
● 1500
● 5000
● 10000
● 30000

Maximum number of archive values that 
can be archived per second
 with an OS single station system: 500

Engineering system (ES) Downloading 
the 
SIMATIC
 stations

PO:
● 100
● 1000
● 10000

License key "AS RT PO"
● Required for download to the AS, 

but not for test or S7 PLC Simulation.
● Only required once in the case of 

redundant systems.

Note

The 100 pre-installed PO licenses can be expanded using the license packages listed here.

The CPU 410 SMART up to 800 POs.

The CPU 410-5H up to 2600 POs (in conjunction with PCS 7 SMART, a maximum of 2400 
POs can be used).

You can obtain further information on CPU 410‑5H in the "PCS 7 CPU 410-5H Process 
Automation" manual (www.siemens.com/pcs7-documentation) under "Hardware manuals for 
SIMATIC PCS 7".

You can get further information on CPU 410 SMART in the "PCS 7 Process Control System 
CPU 410-5H Process Automation/CPU 410 SMART" manual (http://
support.automation.siemens.com/WW/view/en/82142878) .

Licenses
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Differences between PCS 7 SMART and PCS 7 ASIA 4
4.1 Overview of differences

PCS 7 SMART has the following properties: 

Property Influence on PCS 7 SMART
Simplified interface Better overview and simplified operation
Limited process objects Maximum of 2400 POs can be used
No VBA support Mass data engineering is not supported
Limited archiving cycle Maximum 500 values per second
Limited OS channels Only "Named Connections" (PA CPU)+OPC UA/DA/A&E/

HAD(3rd Party)+ProfiBus
Limited project settings Only single station projects possible
No server data Only single station, server is not supported
No block lists editor Read only; editing not possible.
No WinCC CrossReferenceAssistant No extra overview available
Limited PCS 7 project wizard ● Only CPU 410-5H and CPU 410 SMART can be selected

● Only single station projects possible
Limited text library ● Only English and Chinese (simplified) is supported

● Read only; editing not possible
Text Distributor The Text Distributor is not supported.
Limited supported CPUs Only CPU 410-5H and CPU 410 SMART are supported
Limited WinCC object manager ● Client/server not supported

● Maximum of 8 single stations supported
Limited OS project editor ● Maximum of two monitors supported

● Only "single station projects" possible
Limited communication Only S7 connections supported
ES license available only in bundle Coordinated software package
SoftNet RedCon SMART available only 
in bundle

Coordinated software package

CFC CPU and licenses Supports only PA‑CPUs; CFC‑SMART license and hardlock 
are required

PCS 7 SMART 
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4.2 Process objects
The number of process objects (POs) per OS single station system or per PCS 7 SMART 
project is limited to 2400. If the number of used POs exceeds the limit of 2400 POs, you will 
receive a warning message. 

The number of available POs can be increased to a maximum of 2400 by an upgrade with 
PCS 7 license packages. Special PCS 7 SMART license packages are not available. Use the 
license packages available for PCS 7.

Note

The number of usable process objects also depends on the CPU used. You can get information 
on CPU process objects in the section System requirements (Page 7).

Differences between PCS 7 SMART and PCS 7 ASIA
4.2 Process objects
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4.3 ES - Functions

Multiprojects 
The following special note applies to multiprojects in PCS 7 SMART:

● You can only create one OS project.

AS-OS Engineering 
PCS 7 SMART checks the number of process objects during data transmission to the OS 
(WinCC). If the number of process objects is more than 2400, data transfer is canceled and 
an error message appears. 

In this case, reduce the number of configured process objects and transfer the data once more.

Possible connection types between ES and OS 
You can configure a connection between ES and OS in NetPro using:

● S7 channels

– Named connections (for CPU 410‑5H and CPU 410 SMART)

– PROFIBUS

● All OPC channels (can only be used on OS, not between ES and OS)

Any other connections are terminated with an error message during the AS-OS transfer.

PCS 7 SMART project wizard 
The PCS 7 project wizard supports you during project creation. You have the following 
limitations compared to the project wizard in PCS 7:

● You can only select CPU 410-5H or CPU 410 SMART.

● You can only create single station projects.

Differences between PCS 7 SMART and PCS 7 ASIA
4.3 ES - Functions
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4.4 STEP 7

4.4.1 STEP 7 - User interface

The following functions are disabled in the PCS 7 SMART user interface which means they 
are not displayed, or displayed as grayed out only:

Software product Menu command
SIMATIC Manager ● File > S7 memory card

● PLC > Manage M7 system
● PLC > Copy RAM to ROM
● Insert > Station > SIMATIC-300 station
● Insert > Station > SIMATIC S5
● Edit > Project properties → 

dialog box in "Type" area - the "STEP 7" option cannot 
be selected

● Options > CAx data
HardwareConfig ● Station > Import

● PLC > Upload
NetPro ● Edit > Import

4.4.2 STEP 7 - Functions

Command interface 
The command interface is not available.

Differences between PCS 7 SMART and PCS 7 ASIA
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4.5 OS (WinCC)

4.5.1 OS (WinCC) - User interface

The following functions have a different functionality in PCS 7 SMART.

Function Restriction
Server data Server data is not supported as PCS 7 SMART does not have any

client-server architecture.
Text library The text library can be opened as read-only. The contents cannot be

edited.
Text Distributor The Text Distributor is not supported.
WinCC CrossReferenceAs‐
sistant

The WinCC CrossReferenceAssistant is not supported.

Block list editor The block list editor only offers read access. 
The contents cannot be edited.

OS project editor ● Screen settings
The view of the OS project editor is limited to a maximum of two 
screens.

● Project settings
PCS 7 SMART only supports single stations projects. This means 
you cannot change to other project types (e.g., multi‑user project).

4.5.2 OS (WinCC) - Functions

Mass Data Engineering 
The use of mass data engineering with VBA in Graphics Designer is not possible. You can 
use the script languages VBS and ANSI-C in the process pictures without restrictions.

Archiving process data 
The number of archived values for each OS single station system should not exceed 500 
values per second.

Differences between PCS 7 SMART and PCS 7 ASIA
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OS interfaces 
You can use the following interfaces in the OS project editor:

Connection name Area of application
S7 channels:
● Named connections
● PROFIBUS

 
● For CPU 410-5H + CPU 410 SMART

All OPC channels (UA, DA, A&E, HDA)  
WinCC Sysinfo channel  

All other interfaces are not supported.

Web client
A maximum of three web clients are supported with PCS 7 SMART.

Script editor
You can only open global scripts as read-only. You cannot change global scripts.

4.5.3 OS (WinCC) - Supported hardware

Screen 
Each OS of PCS 7 SMART supports the use of up to two screens. You can access the screen 
settings in the menu of the OS project editor.

Differences between PCS 7 SMART and PCS 7 ASIA
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Hardware catalog 5
Hardware catalog 

All I/O devices supported by PCS 7 are also supported in PCS 7 SMART. 

The table below lists the PA SMART products:

Product name Description Article No.
DI32  ET 200PA SMART module 650-8DK80-0AA0
DI32-coated  ET 200PA SMART module 650-8DK80-1AA0
DI16 Diag  ET 200PA SMART module 650-8DK70-0AA0
DI16 Diag- coated  ET 200PA SMART module 650-8DK70-1AA0
DO32  ET 200PA SMART module 650-8EK80-0AA0
DO32- coated  ET 200PA SMART module 650-8EK80-1AA0
DO16 Diag  ET 200PA SMART module 650-8EK70-0AA0
DO16 Diag- coated  ET 200PA SMART module 650-8EK70-1AA0
AI8 Diag  ET 200PA SMART module 650-8AK60-0AA0
AI8 Diag- coated  ET 200PA SMART module 650-8AK60-1AA0
AI16 Diag  ET 200PA SMART module 650-8AK70-0AA0
AI16 Diag- coated  ET 200PA SMART module 650-8AK70-1AA0
AI TC/RTD  ET 200PA SMART module 650-8AR60-0AA0
AI TC/RTD- coated  ET 200PA SMART module 650-8AR60-1AA0
AO8 Diag  ET 200PA SMART module 650-8BK60-0AA0
AO8 Diag- coated  ET 200PA SMART module 650-8BK60-1AA0
IM153  ET 200PA SMART module 650-8PH00-0AA0
IM153- coated  ET 200PA SMART module 650-8PH00-1AA0
RWB PS-IM  ET 200PA SMART module 650-8PA00-0AA0
RWB PS-IM- coated  ET 200PA SMART module 650-8PA00-1AA0
RWB IM-IM  ET 200PA SMART module 650-8PB00-0AA0
RWB IM-IM- coated  ET 200PA SMART module 650-8PB00-1AA0
RWB IO-IO  ET 200PA SMART module 650-8PC00-0AA0
RWB IO-IO- coated  ET 200PA SMART module 650-8PC00-1AA0
CPU 410 SMART Interfaces: 

● PROFIBUS DP
● 2x2 port PROFInet
Work memory (7.5 ns SMART card): 
● Up to 8 MB

6ES7 410-5HN08-0AB0
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Switching from PCS 7 SMART to PCS 7 ASIA 6
6.1 Installation of PCS 7 ASIA

The setup of PCS 7 ASIA gives you the option to expand PCS 7 SMART to PCS 7 ASIA without 
uninstalling it.

Note

Before changing from PCS 7 SMART, save the required projects as an archive in order to be 
able to migrate them into PCS 7 ASIA.

Note

Before upgrading, close all programs that are not required and restart your computer.

Follow the following steps for upgrading from PCS 7 SMART to PCS 7 ASIA.

1. Insert "DVD 1" of the installation data storage medium of PCS 7 ASIA in the DVD drive of 
the PC.

2. Launch the "Setup.exe" file.
The installation wizard starts.

3. Select the preferred language for the installation wizard.
You can choose between English and Chinese.

4. Click on "Next >".
A dialog box with information about performing the installation is displayed.

5. Click on "Next >".
A dialog box for the product information is displayed. Here you have the option to display 
information about PCS 7. 

6. Click on "Yes, I would like to read the notes" to display the information.
Click on "Next >" to continue with the installation.
The installation wizard analyses any existing installations of PCS 7 SMART. The analysis 
may take several minutes. Please wait until the analysis has ended.
A dialog box with the license agreement is displayed.

7. Activate the check box "I accept the conditions..." to accept the license agreements.

PCS 7 SMART 
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8. Click on "Next >".
A dialog box with information about the installation methods is displayed.

9. Activate the option button "Install" to continue with the upgrade from PCS 7 SMART to 
PCS 7 ASIA.

Note

Choose "Install", as the process concerns a new installation from PCS 7 SMART to 
PCS 7 ASIA. 

Choosing "Update" will update exclusively the existing product to a later version number, 
but will not expand the functionality.

10.Click on the "Next >" button.
A dialog box for the user information is displayed.

11.Allocate the name of the user and the company.

12.Click on the "Next >" button.
A dialog box with a choice of languages in PCS 7 opens.
You can choose between English or Chinese. If you have chosen the "English" installation 
wizard, then the languages "English" and "Chinese" are default and cannot be changed. If 
you have chosen the "Chinese" installation wizard, the language "Chinese" is a fixed default 
and "English" can be chosen as an option.

Switching from PCS 7 SMART to PCS 7 ASIA
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13.Click on the "Next >" button.
A dialog box with information about the type of installation opens.

14.Select the type of installation.
Activate the option button "Package installation" to select the installation scope using 
packages.
Activate the option button "User-defined installation" to select the installation scope using 
individual products.
In our case we are choosing the "Package installation".
The installation path is shown in the "Target directory" section.

Switching from PCS 7 SMART to PCS 7 ASIA
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15.Click on the "Next >" button.
A dialog box with selectable "program packages" is displayed.

16.Select the required "program packages" by activating the associated check box. 
To support all functions of your projects, select at least the packages which will also be 
used inPCS 7 SMART.

Switching from PCS 7 SMART to PCS 7 ASIA
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17.Click on the "Next >" button.
A dialog box with selectable programs is displayed. 

Only those programs which are contained in the previously selected "Program Packages" 
will be displayed.
Blue symbols may be shown in front of the entries:

– Blue check mark: The program is already installed on the system.

– Blue Notice symbol: Another requirement must be fulfilled prior to installation. By 
activating the respective check box, details regarding the requirement will be displayed.

– No blue symbol: The program can be installed.

Note

Additional components may be activated when a component is selected. In this case, 
the selected component needs the automatically selected components in order for it to 
function. 

18.Click on the "Next >" button.
A dialog box with a summary of automatic system changes which will be executed during 
the installation is displayed.
If you agreed to the changes, activate the check box "I accept the change to the system 
settings".

19.Click on the "Next >" button.
A dialog box with a summary of the components which are to be installed, the required 
storage space and the approximate duration of installation is displayed.

Switching from PCS 7 SMART to PCS 7 ASIA
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20.If you wish to launch the installation, click on the "Install" button.
A dialog box with the individual installation steps and the current progress is displayed.
A dialog box indicating a necessary restart may be displayed.

21.Click on the "OK" button to perform a restart.
The system is then restarted. The installation will continue automatically after this.
A dialog box with information regarding a successful installation is displayed.

22.Click on "Finish".
The upgrade from PCS 7 SMART to PCS 7 ASIA is complete.

Note

You can get information on the licensing of your version of PCS 7 ASIA on the Internet 
(www.siemens.com/pcs7-documentation) in the "Licenses and configuration limits" manual 
under "Software manuals for SIMATIC PCS 7".

Switching from PCS 7 SMART to PCS 7 ASIA
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6.2 Migrating projects
On the following pages you will learn how the migration of a PCS 7 SMART project to PCS 7 
ASIA is performed.

Note

You can only migrate a project with the SIMATIC manager. The entire project is always 
migrated during a migration.

After migration from PCS 7 SMART to PCS 7 ASIA, the project can only be opened in PCS 7 
ASIA. Once a project is migrated, the migration cannot be undone. The restrictions associated 
with PCS 7 SMART are lifted as a result of migration to PCS 7 ASIA.

Migration from PCS 7 SMART to PCS 7 ASIA 
The migration is performed with an archived project archive in the form of a zip file.

Note

Archive the desired project before performing the upgrade to PCS 7 ASIA.

When migrating a project archive, the original archive data is maintained and can be used on 
another PCS 7 SMART system.

Migrating project archives
Requirement:

You have archived the project with PCS 7 SMART and you can access this file from 
PCS 7 ASIA.

1. Start the SIMATIC Manager.

2. Select the menu command File  > Retrieve.
The "Retrieve" dialog box opens.

3. Select the project archive (zip file) in the file system.

Switching from PCS 7 SMART to PCS 7 ASIA
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4. Click "Open".
The "Select destination directory" dialog box opens.

5. In the file system, select the folder into which you wish to extract the project files.

6. Click the "OK" button.
The "Retrieve" dialog box opens.

Note

This dialog box indicates that the project files in PCS 7 SMART format will be converted to 
PCS 7 ASIA format.

The archive file remains unchanged. Only the unpacked project files are migrated to the 
PCS 7 ASIA format.

7. If you agree, click on the "Yes" button.
The project is converted to PCS 7 ASIA format and saved in the selected folder.
The "Retrieve" dialog box opens and confirms that the migration of the project files.

8. Click on the "OK" button.
The migration is completed. 
The project can now be opened in PCS 7 ASIA.

Switching from PCS 7 SMART to PCS 7 ASIA
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